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Step 1: Loading Fan-Fold Stock into the
Datamax Mark 11, E-4205A

1. Lightly scratch the paper with a pen cap, coin or 2. Plug the the power cable into the printer and
fingernail to look for a black type of smear. This is the power outlet.
printable side and should face up in the printer.

3. To open lid, pull back on gray, arrowed notches on 4. Continue to feed the paper through the front
side of printer. Load the paper through the back of guides, making sure the stock is fed under the small
the printer and feed through the rear, teal guides. For  teal tabs.

best results, keep stock about 12” away from back of

printer unit.



5. Adjust the top and bottom sensors as needed. For
this particular stock, sensors should be both be set at
zero.

7. Turn the printer ON via the power button on the
rear-right side of the printer. | is ON, O is OFF.

6. Ensure the paper is aligned and pulled through to
the black roller edge. Close the lid.

8. The Label Feed button will blink red, then green if
the stock is properly aligned within the printer.

9. Press the Label Feed button to ensure the feed is
working correctly.

Your Datamax-O’Neil E-4205A Mark Il is ready to use!
If you have any additional questions, please contact
our team at: 800-233-9767.
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Step 2: Windows 7/XP Quick Start Guide
Datamax Mark Ill, E-4205A

1. Make sure the printer is OFF and plug a USB cable

into the back of the computer & printer as well as the

power cable into the printer and power outlet, if not

already done.

-
H AutoPlay = —

m DVD Drive (D:) DO ACC

Always do this for software and games:

Install or run program from your media

Run DO.exe
Publisher not specified

General opticns

Open folder to view files
using Windows Explorer

View more AutoPlay options in Control Panel

2. Place the installation disc into your CD-ROM/DVD
drive. The disc should auto-start with a screen as
seen above. Select Run DO.exe.
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do datamax oneil

datamax-oneil

right by our customers.

P

Accessories CD

®
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do datamax oneil Accessories CD

Select your printer:

lass Mark |1
E-Class Mark Il
Ex2
M-Class Mark Il
MP Compact4 Mark 11
H-Class

I-Class
S-Class

3. When the above screen appears, click the arrow in
the bottom-right corner.

4. Click the E-Class Mark Ill option.
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Accessories CD

do datamax oneil

E-Class Mark Il

Install Driver

T Quick Start Guide

7] Operator's Manual
.Q Configuration Utility

T Programmer's Manual

& oo IEE] 2 |

License Agreement l] SEAGULL

SCIENTIFIC

Please read the following license agreement carefully.

WINDOWS PRINTER DRIVER

LICENSE AND LIMITED WARRANTY

Seagull Scientific, Inc. ("Seagull”y grants you a non-exclusive license to use the
accempanying Yindows Printer Driver(s) and related decumentation ("Seagull
Software”), subject to the following provisions. “ou assume full responsibility for the
iselection of the Seagull Software to achieve your intended results, and for the
installation, use, and results obtained from the Seagull Software.

Both the software and the related material are Copyrighted and are protected by law
Title to and all rights and interests in the Seagull Software, wherever resident and on
whateuer media are and shall ramain the nranerhy nf Seannll Furtharmars by neins

@
() | do not accept the terms in the license agreement

| accept the terms in the license agreement

< Back

5. Click the Install Driver option.

6. Select “I accept the terms...” and click Next >

@ oo (=[@] = ]
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The software will be unpacked to the directory listed below. To unpack to a different directory,
either type in the new path or click Browse to select a different directory.

Browse...

Installation Directory

Please select the directory to unpack the software.

Installation Directory:

Space required on drive:
Space availzble on selected drive:

Eroo [=][@] = |
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Installation Information

Follows the instructions below to install the software.

— Instructions
After the drivers are unpacked, install them using the Driver Wizard.

— Options
Run Driver Wizard after unpacking drivers
[ Read installation instructions {contained in “Installation_Instructions html}

<Back || Frish | [ Cancel

7. Leave the Installation Directory as is and click Next >.

8. Deselect “Read installation...” and click Finish.

& oo [=[=] = ]

Seagull Driver Wizard

Welcome to the Seagull Driver
Wizard

This wizard helps you install and remove printer drivers.

What would you like to do?
(@ Install printer drivers

! Upgrade printer drivers

(") Remove printer drivers

o
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Sories

I

i Specify Printer Model
The manufacturer and model determine which printer driver to use.

Spedify the model of your printer.

Printer Model
Datamax-O'Meil A-6212
Datamax-O'Meil A-6212 Mark 1T B
Datamax-O'MNeil A-6310

Datamax-O'Meil A-6310 Mark 1T

Datamax-O'Meil E-42048 Mark 11T

Datamax-O'Meil E-4205A Mark 111

Datamax-O'Neil E-4205e Mark 11

Source:  C:\Seagul
Version: 7.2.1M-0(12/16/2010)

<pack [ mext> | [ cancel

9. Leave “Install printer drivers” selected and click
Next >, then turn on the printer.

10a. Window 7 users: select “Datamax-O’Neil E-
4205A Mark 111” and click Next >.
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Seagull Driver Wizard

Specify Printer Model
- The manufacturer and model determing which printer driver ko use. —

Specify the model of vaur printer,

Manufacturer Printer Model A
Datamax Diatarmna-0'Meil A-4606
Datama-O'Neil Dakamax-O'Neil A-4606 Mark 1T
Datamnax-0'Meil A-6212
Diatarnax-O'Meil A-5212 Mark 1T
Datamax-O'Neil A-6310
Datarnax-0'Mel A-5310 Mark 1T
A Drakamnay:-O'Meil E-42048 Mark 11T

k

v

Browse. ..

Source:  Ci\Seagull
Version:  7.2.1 M-D(12/16/2010)

< Back M Newt = _,] [ Cancel

Specify Port O

A port is used to connect a printer to the computer,

Spedify the part that you are using. If you are connecting using TCP{IF or another part type
not listed below, create a new port,

I Port Type Sl
LPT1: Parallel Port
’ COM1: Serial Port (3600:8M1) L
FILE: Local Port
LISBO01 Wirtual printer port for USB
l nul: Local Port M
SHRFAX: Fax Monitor Port =
. [ Create Port... l [ Configure Port... ]
i
< Back ][ Next = J [ Cancel

10b. Window XP users: select “Datamax-O’Neil”
under Manufacturer and “Datamax-O’Neil E-4205A
Mark 11I” under Printer Model and click Next >

11. Specify port “USB001” and click Next > (USB001
will almost always be the correct option. Sometimes
it can be USB002, USB0O03, etc.)

@ oo == =

Specify Printer Name
Mames are used to identify the printer on this computer and on the network.

Enter a name for this printer.

Printer name: | Datamax-0'Neil E-42054 Mark 11|

[ Use this printer as the default printer

sharing, you must provide a share name.

' Spedify whether or not you want to share this printer with other network users. When
I (@) Do not share this printer

() Share name: | Datamax-O'Neil_E-4205A_Mark_IIT

< Back ][ Mext > ][ Cancel
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Completing the Seagull Driver
Wizard

A new printer will be installed using the following settings:

Datamax-0'Neil E-4205A Mark IIT
<Not Shared>
USE0D1
Mo

Mame:

Share name:
Port:
Default:
Manufacturer:  Datamax-O'Neil
Model: Datamax-0'Neil E-4205A Mark III
‘ersion: 7.2,1M-0 (12/16/2010)

To begin the driver installation process, dick Finish.

< Back ][ Finish J[ Cancel

12. Leave the Printer name as is and click Next >.

Installing Drivers
Please wait while your system is updated.

Installing printer 'Datamax-O'Neil E-4205A Mark IIT'...

!
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I
|

< Back Finish Cancel

i oo = |12 .

13. Click Finish.

14. You will see the printer drivers install.



& oo (=@ = |

Seagull Driver Wizard

Seagull Driver Wizard Completed
Successfully

The following operations were completed successfully:
Installed printer ‘Datamax-0'Neil E-42054 Mark I1T',

Cancel
&
15. Your Datamax printer is now installed. You may 16. Turn the printer ON via the power button on the
click Close and exit the installer. rear-right side of the printer. | is ON, O is OFF.

17. The Label Feed button will blink red, then green if 18. Press the Label Feed button to ensure the feed is
the stock is properly aligned within the printer. working correctly.

We will now run a test print to ensure everything has
been set up correctly.



@ Microsoft Word 2010

Documents

Pictures

Music

Computer

Control Panel

Devices and Printers

Default Programs

Help and Support

»  AllPrograms

| |Search programs and files

19a. Windows 7 users: To print a test page, navigate
to the Windows logo in the bottom-left of your
screen. Then click on Devices and Printers.

o=, |
_—
OU|@ » Contral Panel b Hardware and Sound + Devices and Printers « [# ][ search Devices and rinters )
Addadevice  Addaprinter  Seewhatsprinting  Print server properties  Remove device =5 @

= Devices (4)

4 Printers and Faxes (3)

CutePDF Printer CutePDF Writer Datamax-0)
E-4205A M

See what's printing
¥ Setas default printer

0 ified (1) Printing preferences
> Unspecifies

E Printer properties
Create shortcut
Troubleshoot

Remove device

Properties

Datamax-O'Neil E-4205A Mark Il State: () Defaukt
. Model: Datamax-0'Neil E-4205...
Category: Printer

Status: 0 document(s) in queue

20a. Windows 7 users: Right-click on the Datamax-
O’Neil E-4205A Mark Il and select Printer properties.

" Internet O My Documents
! Inkernet Explorer

7 a My Recent Documents #

(T || E-mail
Iﬁ Microsoft Office Dutlook,

@, Set Program Access and
Defaults

4;‘::_ Printers and Faxes

@ Help and Suppork
p Search

7=/ Run...

All Programs D

@‘ Log CFf |E| Shut Down

19a. Windows XP users: To print a test page, navigate
to the Start menu in the bottom-left of your screen.
Then click on Printers and Faxes.

EBX

% Printers and Faxes

Fle Edt Wiew Favortes Tools  Help

Qe - @ - ¥ Psearch 7o | [

#ddress |94 Prinkers and Faxes i ‘ (€

ata
— ‘

[2] Add = printer _

&5 See what's printing V] EDFCreatnr
Select printing preferences ﬁ Ready

ieY Pause printing

2 share this printer Sharing...

=] Rename this printer Use Printer Offline

X Delets this printer Create Shorteut
I Set printer properties Delete

~Olhleil E-4205A Mark Micrasoft Office Document
nage Writer
Open

Sek as DeFaulk Printer
Printing Preferences.

Pause Printing

Rename

Other Places

[3 Control Panel

2y, Scanners and Cameras
(5} My Documents
{8}ty Pictures

W My Computer

Details

20a. Windows XP users: Right-click on the Datamax-
O’Neil E-4205A Mark Il and select Properties.
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5 Datamax-C'Neil E-4205A Mark II Properties

| Fonts | Tools I About
@ | Sharing I Forts | Advanced I Color Management | Security
=) Datamax-0' Neil E-4205A Mark I
Location:
Comment:
Model: Datarmax-0'Meil E-42054 Mark I
Features
Color: Mo Paper available:
Double-sided: No -
Staple: Mo
Speed: Unknown
Maximum resolution: 203 dpi N
’ Preferences... ] S Print Test Paé?

21. Click on the General tab and select Print Test Page.

22. If set up correctly, the printer will feed and print a
test label.

**Note: The test print may print on two cards over-
lapping the perforation.**

Your Datamax-O’Neil E-4205A Mark Ill is now set up
and ready to use!

Microsoft Word namebadge template and mail merge
instructions can be found on our website:

http.//www.pcnametag.com > Resource Center (far
right column on top of site) > Name Tag Templates >
Datamax Printer Template

If you have any additional questions, please contact
our team at: 800-233-9767.
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Step 3a: Microsoft Office 2010 Quick Start Guide
Datamax Mark Ill, E-4205A

MmEa9-ols Documentl - Micr

Home Insert Page Layout References Review View 7 N
= Envelopes and Labels m
= LY ? " Y =D =D N  Rule
—I (=3 D 1% Ma ds Envelopes | Labels
Envelope’ Start Mail Select Edit Highlight idress Gree Insert Merge Sre

Merge v Recipients v Recipient List | Merge Fields

Address: @ v [7]use return address
Create Start Mail Merge
-
E
I Print Label
@ Full page of the same label Microsoft, 1/2 Letter
) Single label 1/2 Letter Postcard

Row: (1 [ Column: |1 [£ D

Before printing, insert labels in your printer's manual feeder.

) (revanen |

1. Upon opening Word 2010, navigate to and select 2. From there, select Options...
the Mailings tab. From there, select Labels.

Envelopes and Labels ? X Envelopes and Labels ? X
A S
Label Details m
Envelopes | Labels Enve
p L 1 " Preview
Label Options ® M Label Optig Side margins -
Printer information Printer infor Top margin i 5
|
— Vidth 3
(©) Page printers Tray: |Default tray (Continuous Roll) ) Pageq| Height & Number down
Label information Label inforny | . i :
Label vendors: |ENESEEILE E Label vend)|
——Number across—*
Find updates on Office.com Find updatd|
Product number: Label information Product nun |
Type: Other Label Label name: Datamax 4x3
Height: 1.9" Top margin: 0 [  Label height: 3 )
Width: T & Side margin: 0 Label width: 4 +
Page size: 5.05" x 12°
Vertical pitch: 3" %1 Number across: 1 2
= Horizontal pitch: |4 Number down: |1 =2
Page size: 4" roll

= I

Cancel WH T
3. Select Continuous-feed printers, then New Label... 4. Change the Label name to “Datamax 4x3”. Change
the Top margin and Side margin to “0”. Change the

Label height to “3” and the Label width to “4”. Finally,
change the Number down to “1”. Click OK.




Envelopes and Labels

I Envelopes | Labels
[

Label Options » g2

r

Printer informatio

(@ Continuous-feed printers

() Page printers Tray: |Default tray (Continuous Roll)
Label information

Label vendors: | Other/Custom E]

Find updates on Office.com

Product number: Label information
Datamax 4x3 | Type: Custom dot matrix
Height: 7
Width: ¢y
Page size: 5.05" x 12"
[ (i) (o]

5. Confirm Continuous-feed printers is selected and
click OK.

Wd9-0i=

ﬁHome Insert u -
BREELELEREY B

Page Layout References Mailings Review View

Q =

Cover Blank Page Table Picture Clip Shapes SmartArt Chart Screenshot = Hyperlink Bookmark Cross-
Art N

Page~ Page Break > "

Pages Tables Illustrations Links

Labels2 -

pc/nametag®|

Note: Press the space bar once to begin
formatting your name tag. Pressing Enter will
cause the cursor to jump to the next badge.

7. A new document will be created with the
dimensions of the tab. Style your name tag as you see
fit. For best results, center text and logos to ensure
information is contained on a single tag.

Envelopes and Labels (L2 [
Envelopes | Labels
Address: @ ~ [7]use return address

Print Label

Other/Custom, Datamax 4x3
Custom dot matrix

@ Full page of the same label
© single label
Row: |1 +| Column: (1

Before printing, insert labels in your printer's manual feeder.

Print E Fw Document S

l Options... ] [E-poslageProperﬁes.“ ]

6. Click New Document.

Label2 - Microsoft Word

0
)
of

pc/nametag®

Pageseup

8. Navigate to the File tab and select Print. Confirm
your printer is the Datamax-0O’Neil E-4205A Mark 111
and click Print.

Your name tag will now print! If you have any
additional questions, please contact our team at:
800-233-9767.
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Step 3b: Microsoft Office 2007 Quick Start Guide
Datamax Mark Ill, E-4205A

Insert Page Layout References | Mailings Review View

=t =, —_— - =

R

Enveloped\ Labels Start Mail ~ Select Edit Highlight Address Greeting Insert Merge
Merge * Recipients ~ Recipient List || Merge Fields Block Line Field ~

Start Mail Merge ‘Write & Insert Fields

P Rules m@{
) Mateh Fields
Previe

2] Update Labels || pesuf

Create

[EEN

. Upon opening Word 2007, navigate to and select
the Mailings tab. From there, select Labels.

Envelopes and Labels ? Pl
| Envelopes | Labels |
[ 1

Label Options .

Printer information
(@ Continuous-feed printers

Tray: |Default tray (ContinuousRoll) |+

() Page printers
Label information

Label vendors: |[NESE-GLE n

Find updates on Office.com

Product number: Label information
Type: Other Label
Height: 1.9%
Width: Lo

Page size: 5.05" x 12°

3. Select Continuous-feed printers, then New Label...

Envelopes and Labels

Envelopes | Labels

12 it

Address: @ v []use return address
-
@
Print Label
@ Full page of the same label Microsoft, 1/2 Letter
© Single label 1/2 Letter Postcard
Row: [1 P& cowmn: [1 [ D
Before printing, insert labels in your printer's manual feeder.
=~ = =
Print I I New Document l E-postage Properties...

2. From there, select Options...

Envelopes and Labels ?| x|
Label Details (2 [
£
Preview

P |
Label Optia Side margins = |
Printer infof Topmargip I .
© Contin ith I ;
Width——3
HETht ! Number down
——Number across—*
Label name: Datamax 4x3

Top margin: ﬂ Label height: 3 B
Side margin: 0—j| Label width: ﬁ
Vertical pitch: ﬂ Number across: hf
Horizontal pitch: ﬁ Number down: | }

[l
' Page size: 4" roll

T

4. Change the Label name to “Datamax 4x3”. Change
the Top margin and Side margin to “0”. Change the
Label height to “3” and the Label width to “4”. Finally,
change the Number down to “1”. Click OK.




Envelopes and Labels ‘ ? P9 {
| Envelopes | Labels J
| 1

Label Options - -

Printer information
@ Continuous-feed printers

Tray:)|Default tray (Continuous Roll) n
Label information
Label vendors: | Other/Custom n

Find updates on Office.com

) Page printers

Product number: Label information

Datamax 4x3 Type: Custom dot matrix
Height: 3
Width: ¢y

Page size: 5.05" x 127

Detais... | [Newlabel.. | [ Delete |

5. Confirm Continuous-feed printers is selected and
click OK

Mailings Review View Design Layout

Envelopes and Labels L ? wg
Envelopes | Labels
Address: @~ Use return address
-
[
-
Print Label
@ Full page of the same label Other/Custom, Datamax 4x3
© Single label Custom dot matrix
Row: Column: [1 [
Before printing, insert labels in your printer's manual feeder.
[ et ] [ NewDoament | [ options... | [ E-postage Properties... |

6. Click New Document

eview View Design

‘ Home I Insert Page Layout References
2y _—
‘ b cut ' Calibri (Bodyl BETE e @ 3
53 Co K =

Clipboard Font |

=
S —— 1

Paragraph

By I z
Pavsh- (Y Format Painter ‘Iu‘ ‘7
gl il

Note: Press the space bar once to begin
formatting your name tag. Pressing Enter will
cause the cursor to jump to the next badge.

7. A new document will be created with the
dimensions of the tab. Style your name tag as you see
fit. For best results, center text and logos to ensure
information is contained on a single tag.

% cut
43 Copy “
I

Calibri Body] [ -

[BIZ(T - sbe x, x* Aar|¥~ Al

Font

| asebcepc AaBDC: AaBbCe AaB 4
¥ TNomal | TNoSpaci.. Headingl Heading2 Tt S
Cipbosra =

)|
i I 3 )

pc/nametag®

Name: Datamay-ONel E-4205A Mark T

Status:  Printng: 1 docOme e
Type:  Datamax-ONel E-4205A Mark Il
e USBo0L
t

copes
Rimber of e

7 -

5

: .
or pist, pis2, p1s3-p8s3

st [ommen[7] %o

Pt lpages i ravge [o] Pesessersteet tpse [

0
)
7 Gpen
bl =
ﬂ Save As b
@ Print |k
@ Prepare ¥
E Send 3
|é ,:_ Publish *
-«

Close

4 Select a printer, number of copies, and
other printing options before printing

(@ Quick Prim Paragraph

Send the document directly to the default
printer without making changes.

Print Preview
Preview and make changes to pages before

printing.

[} word Options | | X Exit Word |

8. Click the Windows logo in the top-left and select
Print, then Print again. Confirm your printer is the
Datamax-O’Neil E-4205A Mark Il and click OK.

9. Confirm your printer is the Datamax-O’Neil
E-4205A Mark Il and click OK.

Your name tag will now print! If you have any
additional questions, please contact our team at:
800-233-9767.
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Step 3c: Microsoft Office 2003 Quick Start Guide
Datamax Mark Ill, E-4205A

iEii:bEdil View Insert Format Tools Table Window Help

ow.. B on 9 8 dww: @) digad Bid

pEn.. Ctrl+O

Save Ctrl+5
Save As...

Save as Web Page...

Bk D LL

File Search...
Permission »
I Versions...
‘Web Page Preview
|4 | Print Preview
&l Print... Ctrl+P
Send To »
I Properties
Exit
-
1. Upon opening Word 2003, select Page Setup...
from the File menu.

L9 o

-
Page Setup

m Paper Layout

Paper size:
| Custom size IZ|
Width: 4 o
Height: 3 =

Paper source
First page: Other pages:

Default tray (Continuous Rolji# Default tray (Continuous Roljie

Continuous Roll Continuous Roll

Preview
Apply to:
Whole document

5 =

Print Options...
Default...

—_————————————— 4

[ ok ][ cancal |

3. On the Paper tab, set your Width to 4 and your

o 1 R R T O

Page Setup # | ES

Margins Paper Layout

Margins
Top: (1]
Left: a

Bottom: |0 :
Right: |0 5
Gutter position: |Left E|

0| 4[] [+

Gutter: o
Orientation

Portrait Landscape
Pages
Multiple pages: Normal |z|

Preview
Apply to:
Whole document E

2. On the Margins tab, set all of your Margins to 0
and your Orientation to Landscape.

Page Setup

Paper Layout

Paper size:

Custom size

Width: 4

Ak <>.|I|

Height: 3

Paper source

Microsoft Office Word =

0One or more margins are set outside the printable area of the page. Choose the Fix
. button to inaeas&ﬁﬂe appropriate margins.

[ Fix ] [ Ignare

Apply to:
Whole document

E .

Print Options...
Default...

[ Ok ][ Cancel ]

4. Word will alert you that your margins are set

Height to 3 and click OK. outside the printable area of the page. Click /gnore, as
this options allows you to work directly to edge of the

name tag.



Mormal + 28 pt, E; Times

pc/nametag®

Note: Press the space bar once to begin
formatting your name tag. Pressing Enter will
cause the cursor to jump to the next badge.

5. You will now see a document with the correct 6. Style your name tag as you see fit. For best results,
dimensions for the Datamax printer. center text and logos to ensure information is
contained on a single tag.

Ju - eroson word GG S T —
it View Inset Format Tools Table Window Help

- Q Egend ! i A4 Normal + 28 pt, £ - Times New Roman -

| Norma|+2 AR N R G O R G .

View Insert Format Tools Table Window Help

HNew...

¢ QOpen... Ctrl+0

Close

|| Save Ctrl+S

Save As...

pc/nametag®

m Save as Web Page...
#1 | File Search...

Permission >

Printer
Erant < | p c/’l am et a 2® Neme: [ & Datamax-ONel E-4205 Mark I [o] [ eroperties
Web Page Preview Status:  Printing: 1 documents waiting Find Printer ..
_— Type: Datamax-O'Neil E-4205A Mark ITI
Page Setup... Where:  USB001 [C] Print to fie

] Comment: Manual duplex
Q| Print Preview Page range Copies
CtrleP . = 2 H
nt page Selection
Send To 3

separated by commas. For example, 1,3,5-12

Exit

Opeges | ] 11 11 Colete
e
m

F]
|l poges i range oacs per e ]
Scale to paper size: |No scaling [l

e

7. To print, select File, then Print... 8. Confirm your printer is the Datamax-O’Neil
E-4205A Mark 11l and click OK.

Your name tag will now print! If you have any
additional questions, please contact our team at:
800-233-9767
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Changing the Print Temperature
Datamax Mark Ill, E-4205A

Note: Each time your turn on your computer and
before you send print jobs to the Datamax, please
ensure these steps have been taken.

i

Datamax-0O'Neil

E-4205A Mark I T

1. Select Windows 7, Devices and Printers. Right Click
on the installed Datamax-O’Neil.

See what's printing
Set as default printer
Printing preferences h

Printer properties
Create shortcut

Troubleshoot

Remove device

Properties

2. Select Printing preferences

r— N = —————————
@ Datamax-O'Neil E-4205A Mark I Printing Preferences e g Datamax-O'Neil E-4205A Mark IIl Printing Preferences (et S

I | Page Setup | Graphics | Stock | Options | About | Page Setup | Graphics | Stock | Options | About |
I Print Speed Print Speed

sockin S cackin

Print Head Temperature . Print Head Temperature -

Send with job U 10 Send with job U 25

Graphics Options Graphics Options

Encoding: Auto v Encoding: Auto v

[ ok J[ Cacel |[ Ay [[ Hep | (oK J[ cancel |[ sosy |[ Heo |

3. Select the Options tab and select Send with job.
Check the box and slide the Print Head Temperature
to 25.

3. Select Apply then OK. Continue printing with your
Datamax as usual.
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Ethernet Setup with the
Datamax Mark Ill, E-4205A

Note: The Print Server make IP requests at power-up, so before making a network connection to the printer,
consider how your IP addressing needs to be assigned.

The IP addressing on the Internal Ethernet Print Server can be configured in one of two ways: Using a Static IP
Address or Using IP Discovery (DHCP, BootP, or RARP).

As factory default settings, IP Discovery is enabled.

1. With the printer turned OFF, connect the network
cable.

3. The printer will now search for a DHCP server.
Please allow up to 90 seconds for the printer to
receive on IP address.

4. At this point it is recommended to print a Network
Report. This Network Report is generated by the
printer and lists important default information such
as the IP and MAC addresses.

5. Press and hold the P button for 5 seconds.
Release when the LED blinks orange.

6. Verify the printer has obtained a valid IP address
for your network.

7. Once the previous steps have been successfully
completed, you may now use the IP address to install
a print driver and start printing from your Windows
applications.

2. Then turn the printer ON.

NETWORK REPORT

CURRENT PRINTER INFO
MACO: 00:0D:70:08:31:90
IP ADDRESS: 192.168.10.26
SUBNET MASK: 255.255.255.0
GATEWAY: 192.168.10.26
DHCP: *"ENABLED
SNMP: "ENABLED
PORT NUMBER: 9100
NETBIOS NAME: DMX_0B3190

WLAN MODULE - DISABLED -
MODULE FW VERSION: 4.3.0.24
RADIO FW VERSION: 1.1.1.111.8.4.0.145
PORT STATUS: CONNECTED: ESS
SSID: 000b2802d55¢
MACR: 00:0B:28:02:D5:5€
BSS ADDRESS: PROVIDED BY DHCP

J

The information of this label will vary
depending on your configuration and
firmware version.



